ECLIPSE TOMCAT

In dieser Starthilfe .
Installation des Tomcat Plugins ECI | pse TO m Cat

Anpassen der Installation .
Das Tomcat HelloWorld (Servlet) Projekt P I u g N

ot Code Replaceme .
o Starthilfe

1.1. Installation

Folgende Software sollten Sie bereits installiaidn:

- J2SDK1.4 oder neuer (ich habe 1.4.2_02)

- Tomcat 4 oder neuer (ich habe 4.1.27)
Falls Sie wissen mdchten, wie man Tomcat installied konfiguriert, kbnnen Sie dies in der
entsprechenden Starthilfe nachschauen.

Folgend Software brauchen Sie als Plugin:
- Sysdeo Tomcat Plugin
http://www.sysdeo.com/eclipse/tomcatPlugin.html

Laden Sie diese Plugin herunter (tomcatPluginVp}.and installieren sie es als Plugin,
indem Sie es ins VerzeichiCLIPSE_HOME\plugins entzippen.

ECLIPSE_HOME ist typischerweise C:\Eclipse. (bei isi es C:\Java\Eclipse,weil jemand
anders das so wollte).

[N C: Java'Eclipse’,plugins',com.sysdeo.eclipse.tomcat_2.1.0 =1O x|
File Edit Wew Favorites Tools  Help ﬁ
$Back - = - | @Search [ Folders ® | |B Q; o) | [Ee-

Address ID Y JavalEclipse\pluginsicom. sysdeo. edipse.tomcat_2.1.0 j @GD
Folders x Mame # Size | Tvpe | Modified | Attnbutesl

- jas | Clicons File Folder 27.10.2003 11:59
=1 1ava Climg File Folder 27.10.2003 11:59
&1 Edipse J 23 pevioader zip 23KB  WinZip File 25.02,2003 2355 A
--{:I features license.bxt ZKE  Text Document 20.05.2002 09:43 A
=21 plugins plugin, properties 1KE PROPERTIES File 20.05.2002 09:43 A
B3 'com.sysdeo.eclipse tomeat_2.1.0 plugin.xml GKEB XML Document 25.02,2003 23:51 A
-3 org.apache.ant_1,5.3 plugin_bg.propett... 1KE PROPERTIES File 20,05.2002 09:43 A
-3 org.apache.lucene_1.2.1 H plugin_de.propett... 1KE PROPERTIES File 23.12,2002 23:30 A
-39 org.apache, xerces_4.0,13 plugin_fr.properties 1KE PROPERTIES File 20,05.2002 09:43 A
= D org.eclipse.ant.core_2.1.1 plugin_ja.properties ZKEBE PROPERTIES File 20.05.2002 09:43 A
633 org.eclipse.compare_2.1.0 S 7KE  HTML Document 20.05.2002 03:43 a
| org.eclipse.core.boot_2,1.1 g‘]readmeDeanade. . GKE HTML Document 23.12.2002 23:33 A
=0 org. eclipse, core.resources win32_2,1.0 releaseMotesizl.... QKB Text Document 01.04,2003 16:02 A
=0 org.eclpse.core.resources_2.1.1 arc.zip 57 KB ‘WinZip File 01.04.2003 16:03 A
~{] arg.edipse.core.runtime_2.1.1 tomcat.jar 91 KB Executable Jar File 01.04.2003 16:02 n
~{1 org.ecipse.debug.core_2.1.0
[ | org.eclipse.debug.ui_2.1.1
B0 org.eclipse.help. appserver_2.1.0
| org.eclipse.help.ui.win3z_2.1.0 hd
Type: HTML Document Size: 6.0 KB .08 KB {5 my Computer &
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ECLIPSE TOMCAT

Wenn Sie jetzt Eclipse starten, so sehen Sie ynt@tow->Preferences

Fenster:

£ Preferences

g [ 3]

& Warkbench 9 Walue must be an existing file
Tomcat Yersion
- Debug 7 yersion 3.3
(- Help )
Instalfpote { verson 4.0
- Java % Wersion 4,1.%
[+l Plug-In Development R ersanior
(- Team
Tomecat
Tamcak Horme: I Browse. .. |
Konfigurationsdatei I'l.conF'l.server.me Browse. .. |
Projekte zum Tomcat Classpath hinzufiigen
O 1avasmLs Alles auswahlen |
1= SWTStarthife
O Alles abwahlen |
[ Torncat nicht im Debug-Modus starten
Restore Defaults | Apply |
Import. .. | Expott. .. | QK I Cancel |

1.2.

Starten Sie Eclipse und 6ffnen Sie de¢indow->Preferences

Anpassen der Installation

- wahlen Sie den Tomcat “ Knoten.
- wahlen Sie die Version, die Sie installiert habesi (ir : ,Version 4.1.x “)

- geben Sie an, wo sich Jakarta Tomcat befindet

(bei mir: C:\jakarta-tomcat-4.1.27
- bestatigen Sie Ihre Auswahl mipply “
- verlassen Sie das Auswabhlfenster QK

4= preferences

- workbench
Ank

-~ Build Order
[ Debug
- Help
[#- Install/Update
Java
[#- Plug-In Development
[+ Team
=

~ M Einstellungen

Tomcat

Tomcat Yersion
" Version 3.3
 Wersion 4.0.%
 Version 4.1.x
 Wersion 5.x

Tomeat Home | Ciijakarta-tomeat-4,1,27

Browse. ..
Konfigurationsdatei | C:hjakarta-tomcat-4, 1,27 conflserver. xml Browse. ..

Projekte zum Tomcat Classpath hinzufiigen

O 1avazms
& swTstarthilfe

Alles auswahlzn |
Alles abweahlen |

™ Tomeat nicht im Debug-Modus starken

Restore Defauls | Apply I

Impart, ., | Export...

|

=lolx|

)
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ECLIPSE TOMCAT

Beim JVM Submenu habe ich das Java Runtime aufibhgestellt:

ol
- Workbench I¥M Einstellungen
Ank
- Build Order JRE
[+ Debug IJZSDK142 v[
[#-Help . s
__ InstalfUndste Zu ¥M Parametern hinzufiigen
- Java HinzuFiigen
- Plug-In Development e —
Team
(= Tomcak Update
B 1411 Einstellungen Mach oben
Iach unten
Classpath (Wor dem erstellten Classpath)
JariZip
Werzeichnis
Entfernen
Iach oben
Iach unpten
Boot Classpath
Jar)Zip
Werzeichnis
Entfernen
Iach oben
Iach upten
Restore Defaults | Apply |
Impart... | Export... | [o]'4 I Cancel |

Nun kdnnen Sie in der Eclipse Perspektive Tomcdtisar machen unter

» Window->Customize Perspective ¢
|

Select the items to be displayed in the current perspective {lava),

Available [tems: Details:
Window > Show View = & Tomeat beenden
= Other 58 Tomcat neu starten <
[ evs
[u] EETDmcat starten
O oebug
[ Editar MNavigation

[ External Tools

Help

Java Coding

- [¥] Java Debug

- [ Java Element Creation
Java Mavigation

- [¥] Java Open Actions

[ Java Search
Uik

[ Launch

- [#] Resource Havigation

-] Search

[ Software Updates

Ll

Aktivieren Sie unter Qthers->Tomcat “ und bestétigen Sie lhre Auswahl m@K.
Jetzt kdnnen Sie in der angepassten Perspektisgehiedene Tomcat Symbole und Optionen
erkennen (Symbolliste und Mentligmeat™ haben die-setben Optionen):

Java - SOAPPrimzahlServlet.java - Eclipse Platform

File Edit Source Refactor Mavigate ‘Sear b Dject  Tomcat “4@0n  Window Help

|5-0Rs Q88 s -%-s-[d8ds-]|®v]ce-2-]|EYE
[Tomeat beenden] | H 4F w x| [9]504PRimzahiServiet java x] J] SO8PPrimeClisnt. java

Tl Apache ¥ML-RPC package parsers;
8 Javacrundkurs
B JavaxmL3 import Jjava.io.IOException:
B JavaxML4 import Jjava.io.InputStream:
+ import java.io.PrintWriter;
E‘J S TStarthilfe import Jjava.math.BigInteger:

dmaanwt Gotra b d 1 Wwammaratdone

[ e |7 | B
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ECLIPSE TOMCAT

1.3. Tomcat Hello World Projekt

Wir illustrieren das Zusammenspiel zwischen Eclipsd Tomcat mithilfe eines einfachen
Hello World Servlets. Anschliessend schauen wiramswie JSP’s entwickelt und getestet
werden konnen.

1. Wahlen Sie File->New->Project i}

File Edit Source Refactor Navigate Search Project Tomcab Run Window  Help

|® |
Clase Ctrl+F4 @ Class PPrimzahiserviet.j
Close all Chrl+shift+F4 T —
File kage parsSer:
Save Chrl+5 %
@Folder prt java.io
2l Save As... & Interface prt Java.io
ﬁ Save &l Chrl4-Shift+5 @ Package prt java.io
Revert prt Java.ma
- [ Scraphook Page prt java.ut
Move. . @ Source Folder prt java.ut
Renanie, _
ﬂgthar.‘. prt javax.s
Refresh mmport Javax.s
&b Erint.. Chrlr import javax.s:
import Jjavax.s
E2g Import...

- import org.apse
3 Export... import org.aps
import org.wic

Properties Alt+Enter .
import org.wic
1 50APPrimeClient. java [JavaxMLs/...] import org.wic
2 SOAPPrimzahlServiet. java [JavaXMLS]...] import org.wic
import org.xml
Exit

I
2. Im Fenster New Project *“wahlen Sie Java->Tomcat Project
x|

Select s

&
Ein Jawa Projekk mit WaR Strukkur erstellen ﬁ

o~ Java Q Tomcat Projekk
- Plug-in Development m Java Project
L Simple

< Back I Mext = I Eimish Cancel
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ECLIPSE TOMCAT

3. als Projekthamen wahlen wil gmcatPluginStarthilfe “
x|

Java Projekt-Einstellungen

Geben Sie den Projektnamen und Ort des Projektes ein

Project name: | TomcakPluginStarthilfe

Project conbents

o
1\ Javal\Eclipseiworkspace) TomcatPluginstarthilfe Browse. .. |

Direckory:

< Back | Mext = | Finish I Cancel |
Als ,Project Content “ verwenden wir die Default Einstellung, also das

Verzeichnis %ECLIPSE_HOME%\workspace\TomcatPluginStarthilfe “
4. im nachsten Fenster wahlen Sie bittann . XML Datei aktualisieren “
]
Tomcat Projekt-Einstellungen
Tomcat Einstellung fir dieses Projekk erstellen oder &ndern {nur wenn Sie es zulassen)

Anwendungs-URI I [TomeatPluginstarthilfe

¥ Kann $ML Datsi akbualisiersn <

Unterverzeichnis, das als root der Webapplikation gesetzt werden soll {optional) I !

[ext = | Finish | Cancel |

Dabei handelt es sich um die Daterver.xml  im Tomcatconf Verzeichnis.
Indem Sie diese Option aktivieren, brauchen Siejlsvkeine projektspezifischen
Anpassungen an die Server-Konfiguration manueltiszufiihren: der passende
Kontext (Context) wird automatisch eingetragen amdLink in den Workspace
hergestellt.

Die Anwendungs-URI entspricht der Relativadresgadam Server (siehe unten)

5. klicken Sie ,Finish”. Das Projekt ist gestartet!
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ECLIPSE TOMCAT

6. Schauen wir uns die Struktur des Projekts an:

In der Datei.classpath finden wir die oben durchgefiihrten Einstellungeader:

<?xml version="1.0" encoding="UTF-8"?>
<classpath>
<classpathentry kind="con"

path="org.eclipse.jdt.launching.JRE_CONTAINER"/ >

<classpathentry kind="var"

path="TOMCAT_HOME/common/lib/servlet.jar"/>

<classpathentry kind="var" path="TOMCAT_HOME/co

<classpathentry kind="var" path="TOMCAT_HOME"/>

<classpathentry kind="src" path="WEB-INF/src"/>

<classpathentry kind="src" path="work"/>

<classpathentry kind="output" path="WEB-INF/cla
</classpath>

£ lava - Eclipse Platform i

File Edit Source Refactor Mavigate Search Project Tomcat Run Window Help

mmon/lib/jasper-
runtime.jar"/>

sses'"/>

=101 ]

ERCERNEET WIS 3T - Rl

G v .

v X

EAES

-1 JavaGrundkurs

1l JavakML3

Tl JavaxML4

H- 1 JavasMLs

& SwTstarthife

EI&‘J TomcatPluginatarthilfe
Eli}\ IRE System Library [1250K142]

(GE']}), rk.jar - C:YJaval 125K 142 jrellib

Gj}; sunrsasign. jar - C11awal 230K 142)

{3, jsse.jar - CiJavalJ2sDK 142 rellb

E-{ah jce dar - CilJavalJ2S0K1 424iretlib

(g, dnsns.jar - C:Javal1250K 1 424jrellin

ﬁ}; |dapsec.jar - i\ Javal 250K 142 jrel,

ﬁ}; sunjce_provider.jar - Ci\JavalJ250

EI--[?}; TOMCZAT_HOME fcomman/libservet. jar

&-F3 javax.servist

: - f# javax.serviet.http

- H# javax.serviet.jsp

"“:(:'L java. servlet.jsp.resources

E} javaw, serviet.jsp.tagext

{2 javax, servlet resources

E:'L META-INF

El{j}), TOMCAT_HOME/common/libfjasper-runt

7 [ META-INF

- H# org.apache. jasper

+-f# org.apache.jasper logging

E:'L org.apache. jasper .resources

E} org.apache. jasper. runtime

=
&y
@ ------ 1 Apache ¥ML-RPC
»

o=l Outlire x

An outling is not
available,

*-f# org.apache.jasper util

{2 WEB-TNFfste 37 Tasks (0items)

EI{B wiork
¢\ befH ora.apache.jsp

| J’l : | Description

L—_l {= WEB-INF

< | 3 K0 |

Package Explorer I Hierarchy Console ITasks I

Die Verzeichnisseliin ” und “src ” werden nicht weiter benotigt.

EclipseTomcatStarthilfe.doc
© J.M.Joller

6/11




ECLIPSE TOMCAT

7. Jetzt schreiben wir das Hello World Servlet:

die Datei muss im Verzeichnis

» TomcatPluginStarthilfe/WEB-INF/src

Selektieren Sie dieses Verzeichnis.

8. Jetzt legen wir die Klasse an:
“File->New->Class  “

4= Java - Eclipse Platform

Fle Edit Source Refactor Mavigate Search Project Tomcat Run MWindow  Help

d =5 Project... J A
F e O
Close Al Chrl+Shift+F4:
File
Save ChH4 s ' Folder
& save s, @ Interface
Save &l CtrbshifttS o piage
Feverk
- @\ Scrapbook Page
i, % Source Folder
Rename., . iser
Refresh =\ Other... rnor
o Frint.. . Chrl+F
E4g Import...
£ Export...
Properties Alt+Enter

1GChema.java [SwTstarthifefsrcy...]
2 SOAPPrimeClient java [JavaXMLS/...]
3 S0APPrimzahlServiet.java [JavaxMLS(...]

Exit

“angelegt werden.

9. Geben Sie einen Package und einen Klassennamesi;ndabsen wir unsere Klasse

aus javax.servlet.http.HttpServlet

Java Class

Create a new Java dass.

“ ableiten.

Source Folder: | TomcatPluginstarkhilfe WEE-INF/src

Package: | torncatPluginstarthilfe

[ Enclasing type: |

Browse,.,
Browse, .,

Brawse, .,

[ o}

Tarne: | Helloworld

Maodifiers: & public  defaulk € private € protected
[ abstract [ final I~ | static

Superclass: | javax.servlet.http HetpServiet

Interfaces:

‘irhich method stubs would you like bo create?
1 public static void main(Skringl] args);

[T Construckars From superdass
¥ Inherited abstract methods

Browse. ..

Remove

Il

Finish I

Cancel

Die ,public static void main(String[] args)
nicht, obschon ich diese oft stehen lasse, um dndeb als Applikation testen zu

koénnen.

Klicken Sie auf fFinish “, um die Klasse zu generieren.

EclipseTomcatStarthilfe.doc

© J.M.Joller

“ Methode brauchen wir

7/11



ECLIPSE TOMCAT

10.Erganzen Sie oder Uberschreiben Sie nuddi®et() Methode lhresdelloWorld

Servlets. Wahlen Sie dazu im Source Code mit ddntea Maustaste das Popup Ment
»Source->0rganize/Implement Methods...

Unda
Reyvert

Open Declaration

Open Type Hierarchy

Open Super Implementation
Show in Package Explorer

Cuf
Copy.

Paste

Refactor
Local History

Comment el
Uncomment
Farmat

Search

Save:

Organize Imports
Add Import

Override/Implement. Methods, ..

Generate Getter and Setter...
Generate Delegate Methods, ..
Add Constructors From Superclass
Add Javadoc Comment

11.Es o6ffnet sich ein Popup Fenster und Sie konnegelinschten Methoden (in

unserem Fall .,.doGet()

£= Override/Implement Methods _ | m] | 5[

Select methods to override or implement:

r

#-[JO* Genericiervst
#- [c] Chject

1

oDeletefHtpServletRequest, HitpServistRes|
------ O « doHeadiHttpServietRequest, HitpServietResm
------ O & doOptions{HttpServietRequest, HitpServietRe
------ O < doPostiHttpServietRequest, HitpServistRespo
------ O & doPut{HttpServletRequest, HttpServietRespor
------ O < doTrace(HttpServietRequest, HitpServlstResp
------ D & getLastModified{HttpServletRequest)

------ O ¢ serviceiHttpServletRequest, HttpServietRespc
------ [0 @ service(ServletRequest, ServletResponse)

v Group methods by types

Select Al | Deselect Alll

of I Cancel |

Hinweis:

“auswahlen (sofern Sie diese finden!).

falls Sie eine Klasse mit vielen Methoden habenndénnen Sie in deQutline
View “ die gewtinschte Methode leicht finden, da Sieiesdr View die Methoden
aufsteigend oder absteigend sortieren kdnnen, llathoden und Attribute selektiv

verbergen konnen.

12.Speichern Sie Ihr Servlet!

EclipseTomcatStarthilfe.doc
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ECLIPSE TOMCAT

13. Jetzt folgt der eigentliche Tomcat Teuil:

offnen Sie das Kontextmenu Ihres Projekts d.hkselen Sie das Projekt und klicken

Sie auf die rechte Maustaste. Im Popup Menu, sSelekt Sie die Tomcat

Mew

_G#ﬂ?ﬂﬂﬁ'ﬂ*ﬁﬂﬂmﬂ Il
: » [import Java.io.I0Exception;

Go Into import java.util.Enumeration;
Open in Mew Window import javax.servlet.ServletConfig:
Open Type Hierarchy import javax.servlet.ServletContext:
import jawvax.servlet.ServletException;
oé’CuL import javax.servlet.3ervletBRecuest:
gopy import javax.servlet.ServletResponse;
EPaste import jawvax.servlet.http.HttpServlet;
o import javax.servlet.http.HttpiervletReguest;
# Delete import javax.servlet.http.HttpServletResponse
Source 3
Refactor [ R
* jjoller
£y Import... *

* To change the template for this generated
* Windowé&gt:Preferencessgt; Javasgt; Code Gene

éﬁ?Refresh */
public class HelloWorld extends HttpServlet |

£ Expart...

Close Project

Team 3 £F
Compare With 3 * [zee javax.servlet.http.HttpServletfde
Replace With 3 &
Restare from Local Histary, .. protected void doGet (HotpServletRegquest r

Exportiere in die in den Projekkeinstellungen gewsahlte war-Datei 1

Kontext aus server,xml entfernen

[: Properties v i c
[ — Kon |l akbual ] .
-HF javax.serviet.jsp.tagext Figt die Tomeat Bibliotheken zum Projekkerzeugungs-Pfad

-3 javax.serviet resources J5P Atbeitsverzeichnis erstellan

- [ META-INF s

Aktualisieren Sie die Datesierver.xml . Damit wird in der Tomcat Server
Konfiguration ein Link auf |hr Servlet eingetragen:

3 C:jakarta-tomcat-4.1.2 7 confserver.xml - Mi-rosoft Internet Explorer

Option.

=10lx|

File Edit View Favorites Tools Help

d=Eack - = - &) a4 | Qhsearch  [GFavorites  GMedia &4 | BN S B g &

Address I C:hjakarta-tomeat-4, 1,27 confiserver . xml

x| e |Links »

- =Context path="/examples" docBase="examples" debug="0" reloadable="true" crossContext="true">
<Logger classMame="org.apache.catalina.logger.FileLogger" prefi:="localhost_examples_log."
suffis=".txt" timestamp="true" /=
<Ejb name="ejb/EmplRecord" type="Entity" home="com.wombat.empl.EmployeeRecordHome"
remote="com.wombat.empl.EmployeeRecord" /=

+ @l -
+ e
+ @l -
+ @l -

<Environment name="maxExemptions" type="java.lang.Integer" value="15" />
=Parameter name="context.param.name" value="context.param.value" override="false" />
<Resource name="jdbc/EmployeeAppDb" auth="S8ERYLET" type="javax.sql.DataSource" />
+ <ResourceParams name="jdbc/EmployeeAppDb"=>
<Resource name="mail/Session" auth="Container" type="javax.mail.Session" />
<ResourceParams name="mail /Session">
<Resourcelink name="linkToGlobalResource" global="simple¥alue" type="java.lang.Integer" />
</Contexts
<Context path="/TomcatPluginStarthilfe" reloadable="true"
docBase="G! va\Eclipse\workspace\TomcatPluginStarthilfe"
workDir="C:\JavayEclipse\workspace\TomcatPluginStarthilfe\work\org\apache\jsp" />
< /Host=

[

=] ’_ l_ l_ [\ My Computer

A

Hier sehen Sie auch, was es mit der Pfadangal®dwuihat.

EclipseTomcatStarthilfe.doc
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ECLIPSE TOMCAT

14. Jetzt wird’s spannend. Starten Sie den Tomcat §andem Sie entweder auf das
Start Icon klicken oder im Meni untefFgmcat->Tomcat starten “

£~ Java - helloWorld.java - Eclipse Platform
File Edit Source\Gefactor Mawigake Search  Project | Tomcak Run Window  Help

ﬂ = = ﬁg‘;ﬂ @ @ “ :f:fr RO B Y Tomcat starten E

v 5 || [T *Helioy A3 Tomeat besnden
}w | " l_ T £8) Tomeat peu starten o
...... ﬁ apache FMLRPC : Created on 27.10.2003
------ ﬁ JavatGrundkurs

* Tn rthane the tewnmlate for o

15.Unser Servlet befindet sich an der URL
“http://localhost:8080/TomcatPluginStarthilfe/
servlet/tomcatPluginStarthilfe.HelloWorld “

/4§ http://localhost:3080, TomcatPluginstarthilfe/servlet/tomcatPluginstarthilfe.HelloWorld - Microsoft Internet Explorer -10] x|

Fie Edi View Favortes Tooks  Help ‘

GaBack v = - (@D 2] 4| Dsearch GilFavortes @imeda B | By S St @

Address [{&] http: flocalhost:3080, TomcatPluginstarthifie/servletjtomeatPlugnstarthife. Hellowiorld ] @eo [unks >
Der Mann ist das (Cher-)Hzupt der Familie...Die Frau ist der Hals...... und khekanntlich khestirmt der Hals, wo das Haupt hinblickeo!
|&] Dane [ [ [BE ocal intranet Y

Die Zusammensetzung der URL ergibt sich wie folgt:

- Protokoll und Host-Namelttp://localhost:8080

- URI unserer Anwendung/TomcatPluginStarthilfe

- Servlet-URI /servlet/tomcatPluginStarthilfe.Helloworld
(/servlet + Packagename.Klasse)

Hinweis:

falls Sie jetzt eine Fehlermeldung statt der obigaesgabe erhalten haben, dann haben
Sie eventuell Tomcat zwar installiert, aber dakar-Servlet nicht aktiviert.

Wie Sie dieses Problem l6sen kénnen, finden Soeilomcat Starthilfe.

Hinweis:
falls Sie ein Crack sind und einen Deployment Dpsar ,web.xml“ im WEB-INF
Verzeichnis erstellt haben, wird Tomcat diesen talis& beriicksichtigen.

Hinweis:
falls Sie Ihr Programm verandern und abspeichekenat dies Tomcat und meldet,
dass eine neue Version erkannt und geladen wuidamfolgenden Protokoll

ersichtlich:

INFO: Initializing Coyote HTTP/1.1 on port 8080

Starting service Tomcat-Standalone Apache Tomcat/4. 1.27

27.10.2003 15:53:00 org.apache.struts.util.Property MessageResources <init>
INFO: Initializing, config="org.apache.struts.util. LocalStrings', returnNull=true

INFO: JK2: ajp13 listening on /0.0.0.0:8009

27.10.2003 15:53:05 org.apache.jk.server.JkMain sta rt

INFO: Jk running ID=0 time=20/130 config=C:\jakart a-tomcat-4.1.27\conf\jk2.properties
[HelloWorld Servlet]doGet()

WebappClassLoader: Resource /WEB-

INF/classes/tomcatPluginStarthilfe/HelloWorld.class " was modified; Date is now: Mon
Oct 27 15:56:12 CET 2003 Was: Mon Oct 27 15:15:48 C ET 2003
EclipseTomcatStarthilfe.doc 10/11
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ECLIPSE TOMCAT

1.4. Hot Code Replacement

Jetzt wollen wir uns dieses Verhalten zunutze nracimel Hot Code Replacement
testen, also das Ersetzen von Programmcode in dmd#anden Programm.

1. Fur das Debuggen Ihres Hello World Programms seSeerinerBreakpointin der

doGet() Methode:

doppelklicken Sie auf der linken Rand; es solltetgéhuer Punktsichtbar werden

(Breakpoint). Speichern Sie lhr Servlet.

public class HelloWorld extends HttplServlet |

i
% @=zee javax.servlet.http,
*/

protected volL et (HttpServletRequest redq, HttpServletRespohnse res

Tout.println("[HelloWorld Serviet]doGet () ™)

"Ny Big Fat Greek Wedding" */

res.getliciter () .print ("Der Mann ist das (Cher-)Haupt der Familie

res.getWriter () .print ("Die Frau ist der Hals...Vn"):

ervletfdoGet (javax.servlet. http.Hotp!

res.getliciter () .print("...und bekanntlich bestimmt der Hals, wo

2. Wenn Sie jetzt die Servlet URL neu lad&efresh ), startet das Servlet und bleibt

beim Breakpoint stehen.

Andern Sie die Methoden vonprint(...).. . in .printin(...).

Speichern Sie die Anderungen.
Die Ausgabe im Browser andert sich in :

3 http:/ /localhost:8080/TomcatPluginStarthilfe/servlet/tomcatPlugins

=loix|

File Edit “ew Fawvorites Tools Help

daBack + = - 3 o3 | Qsearch [GFavorites Media (% | - S =g &

Address I@j hittp:{flocalhost: 8080 TomeatPluginStarthilfe/servist/tomcatPluginStarthilfe, Helloworld j @Go | Links **

Der Mann ist das (Cher-)Haupt der Familie...
Diie Frau ist der Hals...
...und bekanntlich hestimmt der Hals, wo das Haupt hinblickt!

E

€] bone l_l_l_

Tomcat hat also die Anderung erkannt und gleickidlesichtigt, aus dem Debuggen
heraus!

Hinweis:

Damit Sie die Tomcat Steuerelemente auch in deu®é&rspektive zur Verfigung
haben, miussen Sie die Perspektive entsprechendsampa

“Window->Customize Perspective

x|
Select th to be displayed in the current perspective (Debug)
\\ l;n;: d Details:
(=[F Other
Ocvs
[ pebug
//
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